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13. Equilibrium Module - Description of 
Menus and Options 
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SUMMARY 
 
HSC Equilibrium module enables you to calculate multi-component equilibrium 
compositions in heterogeneous systems easily. The user simply needs to specify the 
chemical reaction system, with its phases and species, and give the amounts of raw 
materials. The program calculates the amounts of products at equilibrium in isothermal and 
isobaric conditions. 
 
The user must specify the substances and potentially stable phases to be taken into 
account in the calculations as well as the amounts and temperatures of raw materials. 
Please note that if a stable substance or phase is missing in the system definition, the 
results will be incorrect. The specification can easily be made in the HSC program interface. 
 
The equilibrium composition is calculated using the GIBBS solver, which uses the Gibbs 
energy minimization method1. The program reads the result files and draws pictures and 
tables of the equilibrium configurations if several equilibria have been calculated. The user 
can toggle between the equilibrium and graphics programs by pressing the buttons. 
 
This version of the Equilibrium module also includes support for electrochemical 
calculations (previously known as Cell module). In Cell Equilibrium calculations, user also 
needs to specify the electrode phases, types of phases (gas/liquid/solid/metal), 
capacitances and discharge equation for the charging/discharging reaction. 
 
The main format Equilibrium module is *.gem8, which contains all the data and formatting 
settings of each definition sheet as well as the phase names. The program can also read 
imported files from the previous HSC versions: 
 
*.GEM file format contains all the data and formatting settings of each definition sheet as 
well as the phase names, etc. while the *.IGI file format contains the data for calculations 
only. *.ICE file format contains the data for single-point calculations of Cell Equilibrium. 
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13.1. Starting the HSC Equilibrium Module 

 

 
Fig. 1. Starting screen. 

There are three ways of creating an input file, see Fig. 1. 
 
1. Press Empty File From Elements. Then specify the elements which are present in 

your system, see Fig. 3. The HSC program will search for all the available species in 
the database and divide them, as default, into gas, condensed and aqueous phases. 
The user can then edit this preliminary input table. 

2. Press Create Empty file if you are already certain of the possible substances and 
phases of the system. 

3. Press Open if you already have an input file which can be used as a starting file. Edit 
the input table and save it using a different name. 

 
If you have an old file format (*.GEM or *.IGI) you can import it from the File menu by 
selecting Import and working with it. You can update thermodynamic data of the old igi file 
to HSC8 database values by update species data from Edit menu, see Fig. 2. 
 
If you only want to calculate the equilibrium compositions and draw a picture with the 
existing files, press Calculate and then press Show Chart. 
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Fig. 2. Update species data of an old igi file. 
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13.2. Starting by Defining the Elements 
 

 
Fig. 3. Specifying the elements of the chemical system. 

If you want to use only some of the species in the calculations, then select them and press 
Import to Selected Species. By decreasing the number of species, you can increase the 
calculation speed and make the solution easier. Especially if you have selected C and/or H 
among the other elements, a very large number of species will be included in the 
calculation and you are advised to decrease the number of species. You can of course try 
with all the species, but usually it is wise to select only such species to the system which 
may be stable. 
 
However, if the stable species are not chosen, the calculated equilibrium results will be 
incorrect. 
 
If there is an odd species in the list then you can click the relevant formula in the list which 
will reveal the whole data set of the species in the database, see Fig. 4. 
 
The species have been divided into rough reliability classes in the database; you may 
select the species available in the most reliable class 1 by pressing Select Class 1. 
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Fig. 4. Deleting undesired species. 

Press Import Items and you can also set the sorting order for the species. You can select 
one of the following sorting methods: Phases (species will be sorted by classes), Gas, 
Aqua, Pure (this sorting method is used for low temperatures), No sorting (all species will 
be in one phase) and Gas, Aqua, Liquids (melt will be added to individual class). The 
sorting order will determine the order of species in the Equilibrium Editor, see Fig. 5. 
 
When you have chosed sorting order of species, press Ok and you will return to the 
Equilibrium Editor window, see Fig. 5. 
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13.3. Giving Input Data for Equilibrium Calculations 
 

 

 
Fig. 5. Specification of the species and phases for the reaction system. 

The Equilibrium Editor consists of two sheets for determining the conditions of the 
equilibrium calculations. In Gibbs version 8 the Options sheet is hided and calculation data 
is specified using the Parameters panel, Fig. 6. You give all the data required to create an 
input file for the equilibrium solvers and for calculating the equilibrium compositions in the 
Species and Parameters panel sheets, see Fig. 5 and Fig. 6. 
 
The most demanding step is the selection of the species and phases, i.e. the 
definition of the chemical system. This is done in the Species sheet of the Equilibrium 
Editor, Fig. 5. You can move around the table using the mouse, or Tab and Arrow keys. 
The other points you should consider are: 
 
1. Species (substances, elements, ions...) 
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You can type the names of the species directly into the Species column, without a 
preliminary search in the Elements window. If you have made the search on the basis of the 
elements, you will already have the species in the Species column. 
 
You can insert an empty row in the table by selecting Row from the Insert menu or by 
pressing the right mouse button and selecting Insert Cells from the pop-up menu. 
 
Rows can be deleted by selecting Row from the Delete menu or by pressing the right 
mouse button and then selecting Delete Cells from the pop-up menu. 
 
You can change the order of the substances by inserting an empty row and using the copy - 
paste method to insert a substance in a new row. The drag and drop method can also be 
used. However, it is extremely important to move the whole row, because there are a 
lot of auxiliary data in the hidden columns on the right side of the sheet. 
 
Please keep the Copy Mode selection on in the Edit menu when rearranging species. This 
will force the program to select the whole row. When formatting the columns and cells, turn 
off the Copy Mode selection in the Edit menu. 
 
Use the (l)-suffix for a species only if you want to use the data of liquid phases at 
temperatures below their melting point. For example, type SiO2(l) if SiO2 is present in a 
liquid oxide phase at temperatures below the melting point of pure SiO2. You may also use 
(s)-suffix if you want to force Gibbs to use solid data at any temperature. 
 
The species can be inserted by selection Species in the Insert menu. Then the Browse 
Database window will appear where you will find the species that you need. You can use 
search, or type a formula or chemical name in the search string, and the program will find 
the species. 
 
You can also type a species formula in a new row in the Equilibrium Editor window, and the 
program will suggest species. 
 
2. Phases 
 
The species selected in the previous step must be divided into physically meaningful 
phases as determined by the phase rows. This finally defines the chemical reaction system 
for the equilibrium calculation routines. The definition of the phases is necessary because 
the behavior of a substance in a mixture phase is different from that in pure form. For 
example, if we have one mole of pure magnesium at 1000 °C, its vapor pressure is 0.45 
bar. However, the magnesium vapor pressure is much smaller if the same amount has 
been dissolved into another metal. 
 
The phase rows must be inserted in the sheet using the Phase selection in the Insert menu 
or using the same selection in the pop-up menu of the right mouse button. The Equilibrium 
module makes the following modifications to the sheet automatically when you insert a new 
phase row in the sheet and: 
 
1. Requests a name for the new phase, which you can change later, if necessary. 
2. Inserts a new empty row above the selected cell of the sheet with a beige pattern. 
3. Assumes that all rows under the new row will belong to the new phase down to the 

next phase row. 
4. Inserts new Excel-type SUM formulae in the new phase row. These formulae 

calculate the total species amount in the phase using kmol, kg, or Nm3 units. 
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When the insert procedure is ready, you may edit the phase row in the following way: 
 
1. The phase name can be edited directly in the cell. 
2. The phase temperature can also be changed directly in the cell and will change the 

temperatures of all the species within the phase. Note that phase and species 
temperatures have effect only on the reaction enthalpy balances. Equilibrium 
temperatures must be specified in the Parameters panel, see Fig. 6. 

3. Note also that you cannot type formulae in the amount column of the phase row, 
because the SUM formulae are located there. You can change the unit used from the 
Units menu. 

 
The first phase to be defined is always the gas phase, and all gaseous species must be 
under the gas phase row. Species of the same phase must be given consecutively one 
after another in the table. As default, HSC Chemistry automatically relocates all the 
gaseous species, condensed oxides, metals, aqueous species, etc. into their own phases if 
you start from the “give Elements” option, see Fig. 1. The final allocation, however, must be 
done by the user. 
 
If there is no aqueous phase, all aqueous species must be deleted. Note that if you have an 
aqueous phase with aqueous ions, you must also have water in the phase! 
 
If you expect pure substances (invariant phases) to exist in the equilibrium configuration, 
insert them as their own phases by giving them their own phase rows or insert all these 
species under the last phase row and select the Pure Substances in the Last Phase 
option on the Parameters panel, see Fig. 5 and Fig. 6. Formation of pure substances is 
possible, especially in the solid state at low temperatures. For example, carbon C, iron 
sulfide FeS2, calcium carbonate CaCO3, etc. might form their own pure phases. 
 
One of the most common mistakes is to insert a large amount of relatively “inert” 
substances into the mixture phase. For example, large amounts of solid carbon at 1500 °C 
do not dissolve into molten iron. However, if both of these species are inserted into the 
same phase, then the equilibrium program assumes that iron and carbon form an ideal 
mixture at 1500 °C. This will, for example, cause far too low a vapor pressure for the iron. 
Therefore, carbon should nearly always be inserted into its own phase at low temperatures. 
 
3. Format 
 
You can format row height, column width, and cells in table of the Equilibrium Editor by 
selecting the Format menu. 
 
4. Input Temperatures of the Species 
 
Input temperatures for the raw material species are essential only in the equilibrium heat 
balance calculations, i.e. if you provide some input amount for a species you should also 
give its temperature. The input temperature does not affect the equilibrium composition. 
You can select the temperature unit by selecting °C or K from the Units menu. Equilibrium 
temperatures must be specified in the Paremeters panel, see Fig. 6. 
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5. Amount of the Species 
 
In this column you give the input amounts of the raw material species. The most important 
point for the equilibrium composition is to put the correct amounts of elements in the 
system. You may divide these amounts between the species as you like. If the correct heat 
balance is required, you must divide the amounts of elements exactly into the same phases 
and in a similar manner as in the real physical world. 
 
You can choose between kmol or kg/Nm3 units by selecting kmol or kg/Nm3 from the Units 
menu. Note that kilograms refer to condensed substances and standard cubic meters (Nm3) 
to gaseous substances. 
 
6. Amount Step for Raw Materials 
 
If you wish to calculate several successive equilibria, you have to give an incremental step 
for one or more raw material species. Then the programs will automatically calculate 
several equilibria by increasing the amount of this species by the given step. Please 
remember to select the Increase Amount option, see Fig. 5, and also give the number of 
steps. Some 21 - 51 steps are usually enough to give smooth curves to the equilibrium 
diagram. 
You can give step values for several species simultaneously. For example, if you want to 
add air to the system, give a step value for both O2(g) and N2(g). Please remember to 
specify the number of steps if a diagram is to be drawn from the results. 
 
7. Activity Coefficients 
 
The simple definition of Raoultian activity is the ratio between the vapor pressure of the 
substance over the solution and the vapor pressure of the pure substance at the same 
temperature: 
 

pure)p
solution) overpa

(
(

=  (1) 

 
The activity coefficient describes the deviation of a real solution from an ideal mixture. The 
activity coefficient f is defined as the ratio between activity a and mole fraction x of the 
species in the mixture: 
 

x
af =  (2) 

 
In an ideal solution, they are therefore defined as a = x and f = 1. As default in GIBBS, the 
activity coefficient of a species in the mixture phase is always 1. 
 
Activity coefficients can be entered as a function of mole fraction of species in the input 
sheet column G. If a constant number is used it is given as an activity coefficient (f) to 
column G, however if an equation is used it should be given as a natural logarithm of 
activity coefficient (lnf) to column G. 
 
Only simple binary or ternary expressions can be utilized directly by the GIBBS solver 
within HSC, such as: 
 

Ln(f) = 8495/T - 2.653 
Ln(f) = 0.69 + 56.8·X24 + 5.45·X25 
Ln(f) = -3926/T 
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Ln(f) = -1.21·X7^2 - 2.44·X8^2 
 
where: 
T  = Temperature in K 
X24 = Mole fraction of the species with row number 24 in the sheet. 
f  = Activity coefficient. 
 
Instead of manually entering the activity coefficient, it is also possible to use pre-defined 
activity models. For example, to calculate the activity coefficients with the Pitzer model 
using the Aqua module, please select “Aqua” in the solution model drop-down list when 
aqueous phase is selected, see Fig. 6. For more information, see Sections 13.4.4, 13.10 
and Chapter 36. 
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13.4. Panel Parameters 
 

 
Fig. 6. Specifying calculation parameters. 
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13.4.1. Operations 
 
There are three buttons in this section. Calculate – Equilibrium will be calculated using the 
user defined parameters. Show Chart – Diagram will be drawn. Cancel – You can cancel 
your last operation. 
 

13.4.2. System Parameters 
 
In this section you can specify parameters and define which of them will be changed. 
 
T – Temperature, P – Pressure, N – Amount, V – Volume, H – Enthalpy. 
 
You can select one of the options in the user defined parameters menu. There are 
temperature, pressure, and amount in every case, for example, if you select the N, H, P 
system, it means that the temperature will be constant in this system. 
 
Specify a 2D or 3D diagram by selecting 1 or 2 in the number of independent variables, 
respectively. 
 

13.4.3. System State 
 
In this section you can specify values or a range of values for the parameters that you 
selected above. 
 
If you have defined increments (steps) for raw material species or a specified range for 
selected parameters then you should also give the Number of Steps required, see Fig. 6. 
Usually 21 - 51 steps give quite smooth curves in the equilibrium diagram. A large number 
will only add more points to the diagram and involve a longer calculation time. 
 
If you have given an amount step for a raw material species, the calculations should be 
made using an increasing species amount. 
 
If you check the Use as base volume option and enter a value for Initial Pressure, the 
program will calculate the initial volume and add to it the value for the volume (or range of 
values) that you specified earlier. 
 

13.4.4. Solution model 
 
User can find the theory of the solution models and instructions of how to make your own 
solution models in section 13.10 for solid and liquid solutions and Chapter 36 for aqueous 
solutions. 
 
First choose the phase where you want to use a solution model in the system sheet. Then 
choose the solution model from the parameters panel and give the number of iterations 
used in the calculations (AC steps). There are three solution models available: Ga - As 
Mixture, Al - Zn Mixture, and Aqua. If the solution model is left blank then this phase is 
treated as an ideal solution. 
 
It is also possible to enter an activity coefficient formula in column G of the input sheet. 
Manually written equations should be entered as a natural logarithm of the activity 
coefficient, see section 13.3. (numbered list 7. Activity coefficients) 
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13.4.5. Advanced Calculation Options 
 
Open Atmosphere Mode (Infinite phase) 
 
The idea of this calculation mode is to balance the system with the external environment as 
a single Gibbs Energy Minimization (GEM) problem. 
 
The system state is termed stationary if the system state does not change in steps. 
 
It is not always possible to find the stationary state for a given system and environment, 
because it is possible that some species will accumulate infinitely in the system. For 
example, if water steam from the environment is condensed in the system's aqueous 
phase, it is possible that the steam will condense infinitely. In such cases the algorithm will 
determine these species and consider their molar amount to be infinite, and the stationary 
state will be found for the rest of the species. 
 
Note: The selection of the species present in the "open" phase should be made with 
caution and only significant species should be added to the open phase. For example, if 
zinc vapor is added to the open gas phase at room temperature, it is possible that solid zinc 
will fully evaporate, which would appear as an incorrect result in the practical sense. Of 
course, zinc evaporation occurs in normal calculations, but is insignificant, because it would 
require something like 1030 steps of Transitory Evaporation to evaporate the zinc. 
 
This mode can be used with some of the other modes. Because the step parameter is not 
defined by this mode, it is possible to use T, P, or raw material amounts as a step 
parameter in the normal mode; and T, V, P or raw material amounts in the Constant 
Volume mode. This mode can be used with the Target Calculations mode. This mode 
cannot be used together with the Adiabatic mode. 
 
Transitory Evaporation Mode (Remove Step % Column ON) 
 
The idea of this calculation mode is to balance the system with the external environment 
step by step. 
 
Unlike the normal calculation mode, when initial parameters for each step are defined by 
the user, in this mode initial parameters are based on the results of the previous step. 
Some part of the "open" phase is deleted, initial species are added, and the next step is 
calculated. 
 
This calculation mode can be used with some of the other modes. In normal mode, T and 
P are fixed across all calculation steps. In the Constant Volume mode, V is fixed (either 
defined by the user or calculated based on the initial gas phase amount), and T or P is 
adjusted automatically. So user must choose amount as step parameter. 
 
Please note that this mode cannot be used together with the Target Calculation mode, 
because it is impossible to determine intermediate (i.e. between adjacent steps) initial 
parameters. Nor can this calculation mode be used together with the Adiabatic mode. 
 
Typical example of Transitory Evaporation mode is calculation procedure where part of the 
gas phase is removed from the chemical system after each calculation step. 
 
Fixed Activity mode 
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This section deals with the Fixed Activity Calculation mode. The main idea of this mode is 
to fix the activity of some species (corresponding to the molar fraction of that species) and 
adjust the initial amount of the species so that this activity constraint is satisfied at 
equilibrium. 
 
This mode supports the Constant Volume and Target Calculations modes. This mode 
does not support the Transitory Evaporation, Open Atmosphere, and Adiabatic calculation 
modes. 
 
Examples of the Transitory Evaporation, Open Atmosphere and Fixed Activity modes 
 
The system consists of H2O, N2 (g), O2 (g), CO2 (g), and CO2 (a). Initially, only H2O, N2 (g), 
O2 (g) and CO2 (g) are present in the system; gases are added to the system in each step, 
see Fig. 7- Fig. 13 (for detailed information of these systems, see Chapter 14). 
 
By calculating this system in the Transitory Evaporation mode (Calculation option Remove 
Step % Column ON checked and Remove step % is here 100 of gas phase - Cell F4 - 
after each step and re-filling the gas phase with option), we get the results in Fig. 8. 
 

 
Fig. 7. Parameters for Transitory Evaporation mode. 
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Fig. 8. Diagram for Transitory Evaporation mode 

By calculating this system in the Open Atmosphere mode (Calcuation options Infinite Gas 
and P #1) with temperature as the step parameter, we get Fig. 9Fig. 9. This chart 
corresponds to the expected values of CO2 dissolution from Fig. 8. 
 

 
Fig. 9. Parameters for Open Atmosphere mode. 
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Fig. 10. Diagram for Open Atmosphere mode. 

You can also calculate this system in the Fixed Activity mode with a coefficient of 0.0003 for 
CO2 (g), see Fig. 11. 
 

 
Fig. 11. Parameters for Fixed Activity mode. 
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Fig. 12. Diagram with Fixed Activity. 

 
Fig. 13. Activity of CO2(g). 

This results in a diagram as in the Open Atmosphere mode, see Fig. 12, and you can 
check that the Activity for CO2(g) is constant as specified in the Fixed Activity coefficient, 
see Fig. 13. 
 
Pure Substances (“Invariant phases”) 
 
All species in the last substance group can be set to be pure substances with the Pure 
Substances in the Last Phase option, see Fig. 6. 
 
Criss-Cobble 
 
HSC will utilize Criss-Cobble extrapolation for the heat capacity of aqueous species at 
elevated temperatures (> 25 °C) if the Criss-Cobble option is selected. 
 
NB! If the Criss-Cobble option is not selected for the GIBBS program, then the activity 
coefficients of aqueous species may be set to 55.509/X(H2O), which will convert the 
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Raoultian activity scale to the aqueous activity scale. This trick will also give the activities of 
the results on an aqueous scale, where the concentration units are expressed as moles per 
liter of H2O (mol/l). 
 

13.4.6. Target Calculation 
 
The idea of the Target Calculations mode is to add a specific constraint to the general 
Gibbs Energy Minimization problem and to use a GEM routine to find the point (with specific 
pressure, temperature, raw material amounts) at which this constraint is fulfilled. 
 
Unlike the Constant Volume and Adiabatic calculation modes, the search can be performed 
over any valid system parameter (raw material amounts, temperature, pressure, volume, 
reaction enthalpy) and the user has to set the search interval explicitly. The result is a list of 
system states within the interval that satisfy the constraint. 
 
For example, you want to find the point where H2O has an amount of 1 mole. Enable Target 
Calculations and set the parameters as in Fig. 14. 
 



 HSC 8 – Equilibrium Module 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev 

14009-ORC-J 20 (53) 

 

Copyright © Outotec Oyj 2014 

 
Fig. 14. Parameters for Target Calculation mode. 

When you press the Calculate button, the program will make the calculation and show the 
results as in Fig. 15. 
 

13.4.7. Chart Options 
 
Online Chart 
 
If you check this option, the points on the chart will be drawn at the same time as they are 
calculated. 
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Header 
 
You may add any kind of heading for the input file, see Fig. 6. The maximum number of 
characters allowed in the heading is 80. The program automatically adds the heading to the 
diagrams, see Fig. 16. 
 

 
Fig. 15. Results for Target Calculation mode 
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13.5. Diagrams 
 
The diagrams can be drawn, for example, as a function of a specified reactant amount or 
equilibrium temperature. You can draw a diagram by pressing Show Chart on the 
Parameters Panel or select Show Chart in the View menu. 
 
You can select species for the axes by clicking the desired button "..." and selecting the 
item in the list box using the mouse. The program shows the recommended selection with 
an arrow, which is the variable used in the calculations. You can select a group of species 
by selecting different phases or/and elements and then selecting the item from this group. 
 

 
Fig. 16. 2D diagram. 



 HSC 8 – Equilibrium Module 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev 

14009-ORC-J 23 (53) 

 

Copyright © Outotec Oyj 2014 

 
Fig. 17. Select data for axes. 

In this menu you can select the data type for the diagram. Usually you can accept the 
default selections by pressing Finish, but the output may be modified. For example, you 
can draw the composition of a gas phase by clicking the Equilibrium Compositions option 
for the y-axis instead of Equilibrium Amount. All the species in one phase must be 
selected if the composition of this phase is to be drawn on the diagram. 
 
If you are working with an aqueous system, you will be given a pH option for the x-axis. 
This option will draw the results as a function of pH. 
 
Temperature and amount units may be selected using the Temperature and Amount 
options. 
 
The number of species is not limited, and all the species included in the equilibrium 
calculations can be selected for the diagram. 
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Fig. 18. Select Species. 

 
Fig. 19. 3D diagram. 

When you press Finish in the Axis menu, Fig. 16, the program reads the equilibrium results 
and draws the diagram using the default scale, font, line width, etc. selections, see Fig. 16 
and Fig. 19. Note that the program inserts the species labels automatically above the 
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maximum point of the curve using the same color for the curve and label. If the line is not 
within the selected x- and y-range or it is on the border then the program will not draw the 
line or the label. 
 
You can edit the diagram, Fig. 16 and Fig. 19, by using several formatting options: 
 
Double click the x- or y-scale numbers or select X-Axis or Y-Axis from the Format menu to 
change, for example, the minimum and maximum values of the x- and y-axes, see Fig. 20. 
In some cases it is also advantageous to change the y-axis to logarithmic scale in order to 
display large variations in amounts or concentrations. From the same window you can 
change the number format of x- and y-axis numbers as well as their font size, color, etc. 
 
1. When the scales are OK, you can relocate any label (species, x- and y-axis heading, 

etc.) with the mouse, using the drag and drop method. First select the label, keep the 
left mouse button down and drag the label to a new location, release the mouse 
button and the label will drop. 

2. The line width of curves, species label font, etc. may be changed by double clicking 
the species labels or selecting the label with the mouse and selecting Format Label 
from the menu. You cannot do this by double clicking the line. The label and curve 
editing window is shown in Fig. 21. Note that line styles other than solid are available 
only for line widths smaller than 0.3 mm. 

3. The walls in a 3D diagram may be changed by selecting Format Walls from the 
Format menu. You can change gridlines, color, axis, etc, see Fig. 22. 

 

 
Fig. 20. Changing scales, scale number format and font settings. 
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Fig. 21. Changing label and line specifications. 

 
Fig. 22. Changing wall specifications. 

1. When you are satisfied with the diagram you can print it by pressing Print. 
2. If you want to see the diagram in a tabular format or use the data of the diagram in 

other programs, such as MS Excel, press Show Table. 
3. You can copy the diagram to the Clipboard by pressing Copy, and paste the diagram 

into other Windows programs. The Copy command uses the Windows Metafile 
format, which enables you to resize the diagram in other Windows applications in full 
resolution. 

4. With Save as vector and Save as raster you can save the diagram in a file. 
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13.5.1. Toolbar 
 
Drawing additional objects or writing some labels on a diagram can be very helpful in some 
cases. You can select one of the shapes (line, arrow, rectangle or circle) or label, see Fig. 
23. If you want some other shape or label you can use the toolbar options. You can format 
the shape by selecting the inner color or border color, line width, line type. You can make 
the figure transparent, move to the back or to the front, see Fig. 23. 
You can delete any shape using        on the toolbar. 

 
Fig. 23. Toolbar. 

 
Fig. 24. 3D diagram with shapes. 

The X and Y labels on the toolbar show the cursor's location. These are only for 2D 
diagrams. 
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13.5.2. Object Editor 
 

 
Fig. 25. Object Editor of the objects in Fig. 24. 

There is one more way to modify diagrams by specifying the coordinates, sizes and colors 
of objects in Object Editor. You can Insert, Delete or Edit the shape. In order to edit you 
should change the parameters of the shape. There are two sheets in Object Editor: Shapes 
and Labels. 
 

13.5.3. Chart Parameters 
 
The Diagram window appears with the Chart Parameters panel instead of the Parameters 
panel. You can use filter options to change the diagram's appearance. 
 
Filter 
 
The main idea of this option is to filter the list of species on the diagram. You can change 
this list by selecting different phases and elements. You can select one, several, or all at 
once (by selecting "All phases" or "All elements"). The option "All must exist" means that 
if you select several elements, the filter should find only the species that include all of the 
selected elements. 
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Fig. 26. Chart parameters. 

 
Fig. 27. Filtering species in a diagram. 
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Auto Scale 
 
This option helps you to use an appropriate scale when the maximum value of the 
diagram's lines is very small. When you check this option, the scale changes automatically 
and you can work with lines with small values. 
 

 
Fig. 28. Auto scale option: uncheck and check (see speciation in Fig. 27 with H2O not chosen). 

Color by Levels 
 
This option allows you to colorize different levels of height charts in different colors. You 
can use this option only in a 3D diagram, see Fig. 29. 
 

 
Fig. 29. Option Color by levels on diagram, see Fig. 19 for comparison. 
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Show Legend on Chart 
 
This option allows you to add one more panel on a 3D diagram legend panel, see Fig. 30. 
This panel duplicates the legend on the Chart Parameters panel, so you can check and 
uncheck species. The filter also changes it. 
 
 

 
Fig. 30. 3D diagram with legend. 
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13.6. Equilibrium Diagram Tables 
 
You can display the equilibrium results in tabular format by pressing Show Table in the 
Diagram window. The Table window has several Excel-type features in a similar way to the 
other spreadsheets in HSC. The most important features are: 
 
1. Copy All puts the whole table on the Clipboard, and pastes this table, for example, 

into MS Excel. You can also copy and paste smaller cell ranges using the Copy and 
Paste selections in the Edit menu, see Fig. 32. 

2. You can also save the table using different formats, such as ASCII text and Excel by 
selecting Save from the File menu. 

3. The Species sheet contains the data of the diagram; the figures in this sheet can be 
edited if you are not satisfied with the results. 

 
There are several formatting options in the Format menu, which can be used to create 
representative tables for printing. The table can be printed using the Print selection in the 
File menu, Fig. 32. Setup and Preview options are also available for printing. 
 

 
Fig. 31. Results sheet, calculated automatically. 

 
Fig. 32. Equilibrium Diagram Table. 
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13.7. Restriction of Cp Extrapolation 
 
This feature allows the user to remove the selected species from the calculation if the 
system temperature falls outside the temperature range of Cp data for that species. The Cp 
data is always given for limited temperature ranges in HSC database. HSC automatically 
extrapolates Cp data outside these ranges. Usually this works just fine, however, in some 
cases Cp extrapolation may lead to errors. Automatic removal of species will solve this 
problem. 
 
The basic approach is as follows: if there are any temperature points at which some of the 
species will be outside its defined temperature range, the user is shown the Warnings 
window that allows marking of the species to be removed outside its temperature range. 
 
Note: the old IGI file format does not contain an upper temperature limit for species. When 
importing IGI files, the program sets the upper limit to 20000 K. 
 
Plain Calculations 
 
The simplest approach is the normal calculations mode (N, T, P). The Warnings window 
uses the temperature range defined in the System State section of the Parameters panel. 
For example, consider the system in NA2SO4.gem8. If the user presses Calculate, the 
Warnings window will be shown, see Fig. 34. 
 

 
Fig. 33. NA2SO4.gem8 test case. 

The Warnings windows show all the species that do not have Cp data at least for some 
points in the system temperature range. This window allows the user to check the species 
that should be deleted outside the defined range. If at some temperature point the selection 
requires the deletion of all species containing some element, a message is shown to the 
user and the calculation is prevented. 
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Fig. 34. Warnings window for NA2SO4.gem8 example. 

 
Fig. 35. Warnings window for NA2SO4.gem8 with species selected for removal. 

After the user presses OK, the calculation will begin. The species marked for removal will 
be removed outside the available temperature range. 

 
Calculations That Search for Temperature (Adiabatic System) 
 
While in the normal calculation mode (N, T, P) the user defines the temperature range for 
the system, there are calculation modes where the temperature range is defined by the 
program. In the Constant Volume (N, P, V) and Adiabatic (N, H, P) modes, the temperature 
is found by binary search in the range 0 – 20000 K. This means that more species are 
subject to extrapolation. The new warnings window handles this by setting the selected 
range to 0 – 20000 K. If the user selects a species to be removed, it will be removed at the 
search points outside the species temperature range. 
 
In the Adiabatic and Constant Volume modes with base volume calculation, the 
temperature of the raw material should be taken into account. If the temperature of the raw 
material lies outside the temperature range for that species, a warning is shown. The 
removal of the species in this case is prohibited because it would lead to an illogical result 
(the user calculates initial system enthalpy based on data that they consider incorrect). 
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Fig. 36. FESO4_adiabatic.gem8 example for adiabatic calculation. 

 
Fig. 37. Warnings for adiabatic calculation. 

An example of adiabatic calculation with and without the removal of some species is 
presented in Fig. 36- Fig. 39. Without species removal, hydrates begin to form at 
temperatures exceeding 4000 °C. The user can prevent this by removing hydrates at high 
temperatures, see Fig. 37. 
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Fig. 38. Adiabatic calculation – without species removal, hydrates are formed at high temperatures. 

 
Fig. 39. Adiabatic calculation – species “H2O”, “FeSO4*7H2O”, “FeSO4*4H2O”, “FeSO4*H2O” 
removed at high temperatures. 
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13.8. General Considerations 
 
Although equilibrium calculations are easy to carry out with HSC Chemistry, previous 
experience and knowledge of the fundamental principles of thermodynamics is also 
needed. Otherwise, the probability of making serious errors in basic assumptions is high. 
 
There are several aspects that should be taken into account because these may have 
considerable effects on the results and can also save a great deal of work. For example: 
 
1. Before any calculations are made, the system components (elements in HSC 

Chemistry) and substances must be carefully defined in order to build up all the 
species and substances as well as mixture phases which may be stable in the 
system. Phase diagrams and solubility data as well as other experimental 
observations are often useful when evaluating possible stable substances and 
phases. 

2. Defining all the phases for the calculation, which may stabilize in the system, is 
equally as important as the selection of system components. You may also select a 
large number of potential phases just to be sure of the equilibrium configuration, but 
this may cause problems in finding the equilibrium. 

3. The definition of mixtures is necessary because the behavior of a substance (species) 
in a mixture phase is different from that in the pure form. The microstructure or activity 
data available often determines the selection of species for each mixture. Many 
alternatives are available even for a single system, depending on the solution model 
used for correlating the thermochemical data. 

 NB! The same species may exist in several phases simultaneously; their chemical 
characteristics in such a case are essentially controlled by the mixture and not by the 
individual species. 

4. If you expect a substance to exist in the pure form or precipitate from a mixture as a 
pure substance, please define such a species in the system as a pure (invariant) 
phase also. This is a valid approximation although pure substances often contain 
some impurities in real processes. All species in the last phase can be set as pure 
substances using the Pure Substances in the Last Phase option, see Fig. 6. 

5. The raw materials must be given in their actual state (s, l, g, a) and temperature if the 
correct enthalpy and entropy values for equilibrium heat balance calculations are 
required. These do not affect the equilibrium compositions. 

6. Gibbs energy minimization routines do not always find the equilibrium configuration. 
You can check the results by a known equilibrium coefficient or mass balance tests. It 
is evident that results are erroneous if you obtain a random scatter in the curves of 
the diagram. You can then try to change species and their amounts as described in 
section 13.3. (2. Phases, 5. Amount of Species). 

7. Sometimes when calculating equilibria in completely condensed systems it is also 
necessary to add small amounts of an inert gas as the gas phase, for example, Ar(g) 
or N2(g). This makes calculations easier for the equilibrium programs. 

8. It may also be necessary to avoid stoichiometric raw material atom ratios by 
inserting an additional substance which does not interfere with the existing 
equilibrium. For example, if you have given 1 mol Na and 1 mol Cl as the raw 
materials and you have NaCl as the pure substance, all raw materials may fit into 
NaCl due its high stability. The routines present difficulties in calculations, because 
the amounts of all the other phases and species, except the stoichiometric one, go to 
zero. You can avoid this situation by giving an additional 1E-5 mol Cl2(g) to the gas 
phase. 
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9. Quite often the simplest examples are the most difficult ones for the Gibbs energy 
minimization routines due to matrix operations. For example, the two-phase H2O(g) - 
H2O -system between 0 - 200 °C. 

10. Sometimes a substance is very stable thermodynamically, but its amount in 
experiments remains quite low, obviously for kinetic reasons. You can try to eliminate 
such a substance in the calculations in order to simulate the kinetic (rate) 
phenomena, which have been proven experimentally. 

11. It is also important to note that different basic thermochemical data may cause 
differences in the calculation results. For example, use of HSC MainDB7.xml or 
MainDB8.xml database files may lead to different results. 
 

The definition of phases and their species is the crucial step in the equilibrium 
calculations and this must be done carefully by the user. The program is able to 
remove unstable phases and substances, but it cannot invent stable phases or species 
which have not been specified by the user. The definition of phases is often a problem, 
especially if working with an unknown system. 
 
Usually it is wise, as a first approximation, to insert all gas, liquid and aqueous species into 
their own mixture phases, as well as such substances which do not dissolve into them, for 
example, carbon, metals, sulfides, oxides, etc. into their own invariant phases (one species 
per phase), according to basic chemistry. If working with a known system, it is, of course, 
clear that the same phase combinations and structural units are selected for the system as 
those found experimentally. These kinds of simplifications make the calculations easier. 
 
The user should give some amount for all the components (elements) that exist in the 
system for the Gibbs solver. 
 
It is also important to understand that, due to simplifications (ideal solutions, pure 
phases, etc.), the calculations do not always give the same amounts of species and 
substances as those found experimentally. However, the trends and tendencies of the 
calculations are usually correct. In many cases, when developing chemical processes, a 
very precise description of the system is not necessary and the problems are often much 
simpler than, for example, the calculation of phase diagrams. For example, the user might 
only want to know at which temperature Na2SO4 can be reduced by coal to Na2S, or how 
much oxygen is needed to sulfatize zinc sulfide, etc. 
 
The Na2SO4.gem8 example in the \HSC8\GIBBS directory shows the effect of temperature 
on Na2SO4 reduction with coal; the same example can be seen also in the HSC color 
brochure, page 3. The calculated compositions are not exactly the same as those found 
experimentally, but from these results it can be seen easily that at least 900 °C will be 
needed to reduce the Na2SO4 to Na2S, which has also been verified experimentally. 
 
The real Na-S-O-C-system is quite complicated. In order to describe this system precisely 
from 0 to 1000 °C, solution models for each mixture phase would be needed to describe the 
activities of the species. Kinetic models would also be necessary at least for low 
temperatures. To find the correct parameters from the literature for all these models might 
take several months. However, with HSC Chemistry the user can obtain preliminary results 
in a matter of minutes. This information is often enough to design laboratory- and industrial-
scale experiments. 
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13.9. Cell Equilibrium calculations 
 
The Cell Equilibrium calculation mode allows calculating equilibrium composition of an 
electrochemical cell using the same calculation method as GIBBS-solver. 
 
The basic definition of an electrochemical system is the same as of a normal system, with 
the following additions2,3: 
 
1. For each phase the user has to provide its type (gas/liquid/solid/metal), whether it is 

an electrode phase (anode or cathode), phase electric capacitance (in Farads) 
2. The user has to provide discharge equation coefficients and total discharge level for 

the system. 
 
Note: in the HSC Cell 7 the capacitance parameter was set as an inverse value of the 
actual electric capacitance, with the unit being inverse Farads (F-1). In the new Cell 
calculations the capacitance is set as actual capacitance, with unit being Farads (F). This 
conversion is handled automatically when importing an *.ICE file. 
 
To create a new Cell calculation file, the same approach as for normal files is used, but the 
menu items with “Cell mode” should be used, like “File -> New -> Empty File (Cell Mode)”. 
 
Open file menu is the same for both Cell and normal calculations. LEADBATT.gem8 have 
been used here as an example. 
 
The phase and species input in the Cell mode is the same as in normal mode. Once the 
phase (or any of the species in it) has been selected,the information in the Phase Data 
section on the right is updated (see Fig. 40). Here the user can set the capacitance (value 
of 0.00001 is typically used for metals), phase type and electrode type (if the phase is 
electrode phase). 
 

 
Fig. 40. Phase data information in Cell mode (LEADBATT.gem8). 

For a complete cell with two or more electrodes, the total charge and the amount of atoms 
present in the system are not sufficient conditions of equilibrium. The additional constraint 
used in the CELL routine is the so-called DISCHARGE EQUATION. This equation 
describes how much charge can be transferred from the cathode to the anode due to the 
redox reactions taking place in the cell before the equilibrium state is reached from the 
initial equilibrium state. 
 
To define discharge equation, one should do the following: 
 
1. Define oxidation numbers for species that participate in the discharge reaction at 

either anode or cathode. If, for example, oxygen gas O2(g) is decomposed on the 
cathode, its oxidation number is 2 * (-2) = -4. The oxidation number of electron 
species is always 1. 



 HSC 8 – Equilibrium Module 
November 20, 2014 
 

 

Research Center, Pori / Petri Kobylin, Lena Furta, 
Danil Vilaev 

14009-ORC-J 40 (53) 

 

Copyright © Outotec Oyj 2014 

2. Set the discharge amount (i.e. the amount of electricity that is transferred from anode 
to cathode in equilibrium). By changing the discharge amount you can calculate 
potentials and compositions at different discharge levels of the cell. The discharge 
amount is set in the System state parameter section similar to other parameters like 
temperature or pressure (see Fig. 41) and can be used as an X-axis value on charts. 
The unit for discharge amount is kmol of electron (kmol e-). 

 
After the electrochemical system has been defined the calculation process and creating 
charts is similar to the normal calculations. Aside from general parameters that can be 
shown on the chart, Cell calculations support Discharge level and Cell voltage as axis 
values (see Fig. 42 and Fig. 43). 
 
Note! Discharge level can also be negative value for certain cells. However if user gives 
negative discharge level for this example LEADBATT.gem8 cell, incorrect very high voltage 
is calculated 9.2·108 V by the model. 
 

 
Fig. 41. System parameters in Cell mode (LEADBATT.gem8). 
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Fig. 42. Chart parameters in Cell mode (LEADBATT.gem8). 

 
Fig. 43. Chart window in Cell mode. 
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13.10. Add-In Development 
 
SUMMARY 
 
The HSC Equilibrium module allows the calculation of multi-component equilibrium 
compositions in non-ideal conditions. The non-ideality of the system is achieved by using 
species activity coefficients that differ from 1. 
 
NB! solution model parameters taken from the literature are dependent on thermodynamic 
data used in the assessment of those parameters and those may differ from the data in 
HSC8 database. That is why it is suggested to use original thermodynamic H, S and Cp 
data inserted in users Own database when new solution models are created and used. 
 
The activity coefficients can be calculated in three ways: 1) by entering the formula into the 
Equilibrium spreadsheet, 2) by using a built-in model (e.g. Aqua) and 3) by using third-party 
DLL add-ins that calculate activity coefficients. 
 
In this document the development of DLL add-ins is discussed. 
 

13.10.1. Structure and Overview of DLL Add-Ins 
 
From the technical point of view, activity coefficient DLLs are Microsoft .NET class libraries 
that implement the specific programming interface, IActivityCoefficientModel. These class 
libraries are loaded on program startup and the activity models found can be used in the 
calculations. 
 
Here are the interfaces that are used by add-ins (VB.NET source code). 
 
	
  	
  	
  	
  <AddInBase()>	
  
	
  	
  	
  	
  Public	
  Interface	
  IActivityCoefficientModel	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReadOnly	
  Property	
  Name	
  As	
  String	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  Sub	
  Init(ByVal	
  species	
  As	
  ISpecies())	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  Function	
  CalculateActivityCoefficients(ByVal	
  amounts	
  As	
  Double(),	
  	
  
	
  	
   	
   	
   ByVal	
  data	
  As	
  ICalculationData)	
  As	
  Double()	
  
	
  
	
  	
  	
  	
  End	
  Interface	
  
	
  
	
  	
  	
  	
  Public	
  Interface	
  ICalculationData	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReadOnly	
  Property	
  Temperature	
  As	
  Double	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReadOnly	
  Property	
  Pressure	
  As	
  Double	
  
	
  
	
  	
  	
  	
  End	
  Interface	
  

	
  	
  	
  	
  Public	
  Interface	
  ISpecies	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReadOnly	
  Property	
  Formula	
  As	
  String	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  Function	
  GetBaseFormula()	
  As	
  String	
  
	
  
	
  	
  	
  	
  End	
  Interface	
  

The main interface is the IActivityCoefficientModel. Add-ins should implement this interface. 
The equilibrium program searches for the implementations of this interface on startup. 
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13.10.2. Calculation interface of activity coefficient model 
 
An activity coefficient model is a routine that gives a list of species in the phase, their 
amounts, temperature and pressure, and calculates the activity coefficients of the species. 
 
Input parameters: 
 
Species names - passed into the Init method (as an array of ISpecies objects, each 
object has a Formula property) 
 
Amounts (mol) - double-array passed into the CalculateActivityCoefficients method 
(order of species is the same as in the array passed into the Init method).  
 
Temperature (K) - passed into the CalculateActivityCoefficients method as part of the 
ICalculationData object. 
  
Pressure (bar) - passed into the CalculateActivityCoefficients method as part of the 
ICalculationData object. 
 
Output parameters: 
 
Activity coefficients - double-array returned from the CalculateActivityCoefficients 
method. The array should have the same size as the amounts array. Values are 
dimensionless, 1 means ideal activity. 
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13.10.3. Creating a new Add-In  
 
To create a new add-in, first you need to create a new Visual Studio 2012/2013 project with 
the type Class Library, using .NET Framework 4.5. In this manual we use VB.NET, but the 
same operations can be done using C#. 
 
Add the following references to the project:  
 
System.AddIn (from .NET Framework) 
 
AddinView (from HSC 8, the default path is 
C:\HSC8\Programs\AddinPipeline\AddInViews\AddinView.dll) 
 

 
Fig. 44. Project references. 

Next, you need to implement the add-in interface, by creating a class that implements the 
interface Outotec.HSC.AddinPipeline.AddinViews.IActivityCoefficientModel. 
 
In order for the class to be recognized as a loadable add-in, it needs to have an AddIn 
attribute. 
 
This leads to the following minimal implementation: 
 
Imports	
  System.AddIn	
  
Imports	
  Outotec.HSC.AddinPipeline.AddinViews	
  
	
  
<AddIn("AddinTest",	
  Version:="1.0.0.0")>	
  
Public	
  Class	
  AddinTest	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel	
  
	
  
	
  	
  	
  	
  Public	
  ReadOnly	
  Property	
  Name	
  As	
  String	
  _	
  
	
  	
  	
  	
  	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.Name	
  
	
  	
  	
  	
  	
  	
  	
  	
  Get	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Throw	
  New	
  NotImplementedException()	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  Get	
  
	
  	
  	
  	
  End	
  Property	
  
	
  
	
  	
  	
  	
  Public	
  Sub	
  Init(ByVal	
  species	
  As	
  ISpecies())	
  _	
  
	
  	
  	
  	
  	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.Init	
  
	
  	
  	
  	
  	
  	
  	
  	
  Throw	
  New	
  NotImplementedException()	
  
	
  	
  	
  	
  End	
  Sub	
  
	
  
	
  	
  	
  	
  Public	
  Function	
  CalculateActivityCoefficients(amounts	
  As	
  Double(),	
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  data	
  As	
  ICalculationData)	
  As	
  
Double()	
  _	
  
	
  	
  	
  	
  	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.CalculateActivityCoefficients	
  
	
  	
  	
  	
  	
  	
  	
  	
  Throw	
  New	
  NotImplementedException()	
  
	
  	
  	
  	
  End	
  Function	
  
	
  
End	
  Class	
  
 
Below is a detailed description of the implementation. 
 
The AddIn attribute has to include the add-in name and version. 
 
<AddIn("AddinTest",	
  Version:="1.0.0.0")>	
  
 
The name property should return the string that will be shown as the model name in the 
HSC Gibbs interface. 
 
Public	
  ReadOnly	
  Property	
  Name	
  As	
  String	
  _	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.Name	
  
	
  	
  	
  	
  Get	
  
	
  	
  	
  	
  	
  	
  	
  	
  Return	
  "Addin	
  Test"	
  
	
  	
  	
  	
  End	
  Get	
  
End	
  Property	
  
 
The Init method is called by HSC Gibbs before the calculation of the phase, and an array of 
ISpecies objects is passed into it. It is expected that the method keeps the species names 
from this array somewhere. 
 
Private	
  _species	
  As	
  IEnumerable(Of	
  ISpecies)	
  
	
  
Public	
  Sub	
  Init(ByVal	
  species	
  As	
  ISpecies())	
  _	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.Init	
  
	
  	
  	
  	
  _species	
  =	
  species	
  
End	
  Sub 

The CalculateActivityCoefficients method is called by HSC Gibbs during the phase 
calculations. The parameters passed are the amounts of species in mol (species order and 
number correspond to the species passed into the Init method) and the ICalculationData 
object that provides the temperature in Kelvins and pressure in bars. The method should 
return a double-array with the same size as the species and amounts of arrays. 
 
Public	
  Function	
  CalculateActivityCoefficients(amounts	
  As	
  Double(),	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  data	
  As	
  ICalculationData)	
  As	
  Double()	
  _	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel.CalculateActivityCoefficients	
  
	
  	
  	
  	
  Dim	
  result()	
  As	
  Double	
  
	
  	
  	
  	
  ReDim	
  result(_species.Count	
  -­‐	
  1)	
  
	
  	
  	
  	
  For	
  i	
  As	
  Integer	
  =	
  0	
  To	
  _species.Count	
  -­‐	
  1	
  
	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  1.0	
  
	
  	
  	
  	
  Next	
  
	
  	
  	
  	
  Return	
  result	
  
End	
  Function 

The values returned by the CalculateActivityCoefficients method are treated by HSC Gibbs 
as species activity coefficients, with 1 meaning an ideal system. During the Gibbs energy 
calculations, the natural logarithm of the activity coefficient is used. So, if your activity 
coefficient model provides the logarithm of the activity coefficient, you need to exponentiate 
it in the CalculateActivityCoefficients method, so that the correct logarithm is achieved in 
the Gibbs energy calculations. 
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After you have compiled the class library, you need to place the DLL into a separate folder 
in the Programs/AddinPipeline/Addins directory of the HSC 8 installation. The folder should 
have the same name as the addin DLL. For example, the addin DLL called AddinTest1.dll 
should be placed in the folder C:\HSC8\Programs\AddinPipeline\Addins\AddinTest1 
 
Once the library has been placed in the corresponding folder, you can start HSC Gibbs. 
The new model should be available in the solution model drop-down list. You can also 
check the available models in the Window - Add-Ins menu (Fig. 45). 
 

 
Fig. 45. Available add-ins in HSC Gibbs module. 
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APPENDIX A. Redlich-Kister solution model 
 
In this appendix, the Redlich-Kister solution model equation for a binary system has the 
form of Equation (1). 
 

ExG = xixjΣkn·(xi-xj)n,      (1) 
 
where kn can be any temperature- and pressure-dependent term. 
 
This can be written for each component of the binary system as 
 

ExGi = RTlnfi = xj
2[k0 + Σkn·(xi-xj)n-1[(2n+1)xi - xj]]  (2) 

 
ExGj = RTlnfj = xi

2[k0 + Σkn·(xi-xj)n-1[xi - (2n+1)xj]],  (3) 
 
where R is the gas constant 8.31431 Jmol-1K-1 
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APPENDIX B. Ga - As solution model 
 
HSC 8 includes a model for a Ga - As liquid binary phase. The Redlich-Kister parameters 
used in this example are: 
 
LIQUID phase 
k0 = -25503.6 - 4.3109·T 
k1 = 5174.7 
 
where the temperature unit is Kelvin. 
 
Imports	
  System.AddIn	
  
Imports	
  Outotec.HSC.AddinPipeline.AddinViews	
  
	
  
<AddIn("Ga	
  -­‐	
  As	
  Mixture",	
  Version:="1.0.0.0")>	
  
Public	
  Class	
  GaAsMixtureAddin	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel	
  
	
  
	
  	
  	
  	
  Private	
  _species	
  As	
  IEnumerable(Of	
  ISpecies)	
  
	
  
	
  	
  	
  	
  Private	
  _GAindex	
  As	
  Integer	
  =	
  -­‐1	
  
	
  	
  	
  	
  Private	
  _ASindex	
  As	
  Integer	
  =	
  -­‐1	
  
	
  	
  	
  	
  Private	
  _phaseCorrect	
  As	
  Boolean	
  =	
  False	
  
	
  
	
  	
  	
  	
  Public	
  ReadOnly	
  Property	
  Name	
  As	
  String	
  Implements	
  IActivityCoefficientModel.Name	
  
	
  	
  	
  	
  	
  	
  	
  	
  Get	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Return	
  "Ga	
  -­‐	
  As	
  Mixture"	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  Get	
  
	
  	
  	
  	
  End	
  Property	
  
	
  
	
  	
  	
  	
  Public	
  Sub	
  Init(ByVal	
  species	
  As	
  ISpecies())	
  Implements	
  
IActivityCoefficientModel.Init	
  
	
  	
  	
  	
  	
  	
  	
  	
  _species	
  =	
  species	
  
	
  	
  	
  	
  	
  	
  	
  	
  _phaseCorrect	
  =	
  False	
  
	
  	
  	
  	
  	
  	
  	
  	
  _GAindex	
  =	
  -­‐1	
  
	
  	
  	
  	
  	
  	
  	
  	
  _ASindex	
  =	
  -­‐1	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  For	
  i	
  As	
  Integer	
  =	
  0	
  To	
  _species.Count	
  -­‐	
  1	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  formula	
  =	
  _species(i).Formula	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  formula	
  =	
  "Ga(l)"	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  _GAindex	
  =	
  i	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  formula	
  =	
  "As(l)"	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  _ASindex	
  =	
  i	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  _GAindex	
  >=	
  0	
  And	
  _ASindex	
  >=	
  0	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  _phaseCorrect	
  =	
  True	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Exit	
  For	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  Next	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  _species.Count	
  <>	
  2	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  _phaseCorrect	
  =	
  False	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  Not	
  _phaseCorrect	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Throw	
  New	
  Exception("Cannot	
  apply	
  model	
  to	
  this	
  phase")	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  End	
  Sub	
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  Public	
  Function	
  CalculateActivityCoefficients(amounts	
  As	
  Double(),	
  data	
  As	
  
ICalculationData)	
  As	
  Double()	
  Implements	
  
IActivityCoefficientModel.CalculateActivityCoefficients	
  
	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  result()	
  As	
  Double	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReDim	
  result(_species.Count	
  -­‐	
  1)	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  amounts(0)	
  +	
  amounts(1)	
  <=	
  0	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Return	
  {1.0,	
  1.0}	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  fractions()	
  As	
  Double	
  =	
  {amounts(0)	
  /	
  (amounts(0)	
  +	
  amounts(1)),	
  
amounts(1)	
  /	
  (amounts(0)	
  +	
  amounts(1))}	
  
	
  	
  	
  	
  	
  	
  	
  	
  For	
  i	
  As	
  Integer	
  =	
  0	
  To	
  _species.Count	
  -­‐	
  1	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  1.0	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  _phaseCorrect	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  i	
  =	
  _GAindex	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  Math.Pow(Math.E,	
  ((fractions(_ASindex))	
  ^	
  2)	
  *	
  (-­‐
25503.6	
  -­‐	
  4.3109	
  *	
  data.Temperature	
  +	
  5174.7	
  *	
  (3	
  -­‐	
  4	
  *	
  fractions(_ASindex)))	
  /	
  
(8.31431	
  *	
  data.Temperature))	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  ElseIf	
  i	
  =	
  _ASindex	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  Math.Pow(Math.E,	
  ((1	
  -­‐	
  fractions(_ASindex))	
  ^	
  2)	
  *	
  (-­‐
25503.6	
  -­‐	
  4.3109	
  *	
  data.Temperature	
  +	
  5174.7	
  *	
  (1	
  -­‐	
  4	
  *	
  fractions(_ASindex)))	
  /	
  
(8.31431	
  *	
  data.Temperature))	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  Next	
  
	
  	
  	
  	
  	
  	
  	
  	
  Return	
  result	
  
	
  	
  	
  	
  End	
  Function	
  
	
  
End	
  Class	
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APPENDIX C. Al - Zn solution model 
 
HSC 8 includes a model for an Al - Zn binary system (liquid, solid FCC, and solid HCP 
phases). The Redlich-Kister parameters used in this example are: 
 
LIQUID phase 
k0 = 10483.5 - 4.74442·T 
k1 = -210.4 + 0.85139·T 
 
FCC phase 
k0 = 11014.8 - 3.71812·T 
k1 = 1546.9 + 1.60179·T 
k2 = -308.7 
 
HCP phase 
k0 = 17047.8 - 10.37525·T 
 
where the temperature unit is Kelvin. 
 
Imports	
  System.AddIn	
  
Imports	
  Outotec.HSC.AddinPipeline.AddinViews	
  
 
<AddIn("Al	
  -­‐	
  Zn	
  Mixture",	
  Version:="1.0.0.0")>	
  
Public	
  Class	
  AlZnMixtureAddin	
  
	
  	
  	
  	
  Implements	
  IActivityCoefficientModel	
  
 
	
  	
  	
  	
  Private	
  _species	
  As	
  IEnumerable(Of	
  ISpecies)	
  
	
  	
  	
  	
  Private	
  _phaseMode	
  As	
  PhaseMode	
  
	
  	
  	
  	
  Private	
  _indexAl	
  As	
  Integer	
  =	
  -­‐1	
  
	
  	
  	
  	
  Private	
  _indexZn	
  As	
  Integer	
  =	
  -­‐1	
  
	
  	
  	
  	
  Private	
  _phaseCorrect	
  As	
  Boolean	
  =	
  False	
  
	
  
	
  	
  	
  	
  Public	
  Function	
  CalculateActivityCoefficients(amounts()	
  As	
  Double,	
  data	
  As	
  
ICalculationData)	
  As	
  Double()	
  Implements	
  
IActivityCoefficientModel.CalculateActivityCoefficients	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  Not	
  _phaseCorrect	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Return	
  Nothing	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  result()	
  As	
  Double	
  
	
  	
  	
  	
  	
  	
  	
  	
  ReDim	
  result(_species.Count	
  -­‐	
  1)	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  amounts(0)	
  +	
  amounts(1)	
  <=	
  0	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Return	
  {1.0,	
  1.0}	
  
	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  fractions()	
  As	
  Double	
  =	
  {amounts(0)	
  /	
  (amounts(0)	
  +	
  amounts(1)),	
  
amounts(1)	
  /	
  (amounts(0)	
  +	
  amounts(1))}	
  
	
  	
  	
  	
  	
  	
  	
  	
  If	
  _phaseMode	
  =	
  PhaseMode.Liquid	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  For	
  i	
  As	
  Integer	
  =	
  0	
  To	
  _species.Count	
  -­‐	
  1	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  1.0	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  T	
  =	
  data.Temperature	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  x7	
  =	
  fractions(_indexZn)	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Dim	
  x6	
  =	
  fractions(_indexAl)	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  If	
  i	
  =	
  _indexAl	
  Then	
  
	
   	
   	
   	
  	
  	
  	
  result(i)	
  =	
  Math.Pow(Math.E,	
  (x7	
  ^	
  2)	
  *	
  (10483.5	
  -­‐	
  4.74442	
  *	
  T	
  +	
  
(-­‐210.4	
  +	
  0.85139	
  *	
  T)	
  *	
  (3	
  *	
  x6	
  -­‐	
  x7))	
  /	
  (8.31431	
  *	
  T))	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  ElseIf	
  i	
  =	
  _indexZn	
  Then	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  result(i)	
  =	
  Math.Pow(Math.E,	
  (x6	
  ^	
  2)	
  *	
  (10483.5	
  -­‐	
  4.74442	
  *	
  T	
  +	
  
(-­‐210.4	
  +	
  0.85139	
  *	
  T)	
  *	
  (x6	
  -­‐	
  3	
  *	
  x7))	
  /	
  (8.31431	
  *	
  T))	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  End	
  If	
  
	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  Next	
  
	
  	
  	
  	
  	
  	
  	
  	
  ElseIf	
  _phaseMode	
  =	
  PhaseMode.SolidFCC	
  Then	
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  For	
  i	
  As	
  Integer	
  =	
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